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President’s Proclamation
Did you know? We live in a Good News–Bad News world,
folks....
[GN] Our Lunar Eclipse public events got great media coverage
and LOTS of folks had a serious interest and came out! But
[BN] the moon stayed in hiding and lots of folks were
disappointed!
[GN] We get 2 shots at a Messier Marathon this year – that
means twice the fun! However [BN] we can’t get all 110 objects
- darn!
[GN] Santa Fe has responded generally in favor of our
observatory proposal, though [BN] not surprisingly we have a
few new hoops to jump through and thus our building schedule
has slid.
[GN] We have several neat club-logo candidate designs for our
soon-to-be ASLC shirts and hats, but [BN] only 1 or 2 can win.
(*Don’t forget to come to the March meeting and vote!)

Nils Allen at a Telescope
Making Class

[GN] I see new visitors, new members, new outreach opportunities and new hardware showing up all over,
but [BN] do we have enough members willing to welcome and mentor the new folks, man our outreach
events, and generally wave the “new hardware” clouds away? ;~)
[GN] We asked “Why not become more involved in your Society?” and some responded (Steve Henderson
and Bernie Joplin come to mind) by joining outreach efforts and contributing HDO articles, but [BN] the
HDO needs more fresh authors - are you working on your article?
[GN] At the next meeting our most experienced member and Director Emeritus Walter Haas will impart
unique insights from a lifetime of pursuing solar system astronomy, yet [BN] we could do better at utilizing
the knowledge, experience, and history embodied in our elder members.
OK, enough of that, already! Consider the following a heads-up, folks - April is coming soon and it’s busy!
April 5 is Messier Marathon Chance Two; April 12 is the 2nd International Sidewalk Astronomy Night think Super Moongaze; April 19 is the Chihauhuan Desert Nature Park star party - think lotsa nature and
people; April 26 is Earth Day 2008 @ Apodaca Park – think Ren Faire but easier. More info to come....
So, are you ‘having fun’ yet? I hope so. If not, figure out why and let me know! Stellar Stargazin’! — Nils
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Next Meeting
The March meeting will be held at 7:30pm in the usual place
(Main Campus of the Dona Ana Community College, room
77). The speaker will be Walter Haas who will give us his
unique insights from a lifetime of pursuing solar system
astronomy.
The Astro Tidbits Group (contact: Rich Richins) will meet prior
to the March meeting at 7pm. The Imagers Group (contact:
also Rich Richins) will meet prior to the April meeting. Anyone
is welcome to attend these special interest group pre-meetings.
Other events planned for March and early April include:
Dark Sky Observing at the Upham dark sky site, Saturday,
April 5 (Messier Marathon, second try)
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ASLC Moon Gaze, International Delights Cafe, Saturday, March 15 and April 12
Please see the ASLC website for further information (http://www.aslc-nm.org).

Observing Near Earth Asteroids or Scanning for Doomsday
By Bert Stevens
Most minor planets orbit the Sun between Mars and Jupiter, but some come very close to the Earth. In the
past, some have actually hit the Earth, causing the mass extinction of species. A new impact might extinguish
Homo sapiens, or at least destroy our civilization. Since this would be very uncomfortable for astronomers
(among others), I track these Near Earth Objects (NEOs), watching for the one out of hundreds of thousands
that may impact the Earth. The term “objects” here refers to either asteroids or comets.
In order to keep track of where these NEOs will be in the future and if they might hit the Earth, I need to
take very precise measurements of their positions against the background stars. These measurements are
submitted to the Minor Planet Center (MPC, http://www.cfa.harvard.edu/iau/mpc.html) of the International
Astronomical Union which compiles the positions reported by astronomers from all over the world. They
then use the positions to compute the orbits of all minor planets.
The first step in an observing run is to use the MPC’s Near Earth Asteroid Observation Planning Aid to
select targets. This tool allows the observer to input selection parameters and get a list of targets that need
observing. One of the most important parameters is the faintest magnitude object I can observe.
During the dark of the Moon, I will go as faint as a predicted magnitude of 20.7 V. To get a strong enough
image of an object that faint, I will have to accumulate almost three hours of exposure time. This will give
me enough images to build three independent stacks, each stack contributing one measurement. The MPC
recommends three to five measurements on each object per night. Since magnitude predictions of minor
planets are somewhat uncertain, the exposure lengths I use will allow me to get measurements of the object
even if some exposures are unusable, or the minor planet is a few tenths of a magnitude fainter than it should
be. This could happen either because previous observations were wrong, or the minor planet is oblong and
rotating, presenting different cross-sections (and hence magnitudes) to us at different times.
Other parameters include declination (nothing south of -25 degrees or north of +55 degrees), if the object is
!!
in the Milky Way (nothing within 15 degrees of the plane of the Milky Way) and the uncertainty of!!
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Aid gets converted into an Excel spreadsheet,
and in the process, I automatically compute
some additional values, including subframe
exposure time, number of subframes and total
running time for each object. The list gets
separated into those objects that need
observing immediately and those that will need
observing soon. I sequence the first group by
Right Ascension to become a tentative
observing plan.

2007 TU24 came
withing a half
million miles of the
Earth on January
30, 2008. This is a
stack of 48 3second exposures
locked on the stars.
The subframes were
about 15 seconds
apart. At this time,
the minor planet
was magnitude 11

In addition to these NEOs, minor planets I have
discovered in the past that need observing are
also added to the plan. I make a check each
month of all my discoveries, and determine
which ones need observing and are brighter than magnitude 20.7 V so I can get the desired additional
observations. This keeps them from getting lost in the future.
Finally, the MPC also keeps a list of suspected new NEO discoveries and their approximate positions, called
the NEO Confirmation Page (NEOCP). These objects have only been observed on one night, so their
positions and magnitudes are very uncertain. If I need some additional targets, I pull some objects from this
list. But these targets might not be NEOs, or could even be comets. Also, the predicted positions given on
the NEOCP could be so uncertain that the object may not even be in my field-of-view, and I will be imaging
an empty piece of sky, a great waste of observing time. It also takes substantial effort to get these targets
formatted correctly for use, so I usually leave these to other observers.
With all these targets sequenced from the west in the evening to the east in the morning (Right Ascension
sequence), I now start to refine an observing plan that can be completed in one night. There are almost
always more targets than time to observe them. Two of the factors that are used to weed out targets from
the plan include proximity of the target to the Moon (and the Moon’s age), and how badly observations of
the target are needed. The targets must also be spread throughout the night. If all the targets are in the
morning sky, but the exposures will require all night to be taken, then different targets must be picked to give
a uniform spread. The Excel spreadsheet shows the time that the telescope will finish with each target. The
optimum is for the last target to finish at the beginning of nautical twilight.
To fit the targets into the available time, I remove those that need observing the least, especially among
those that happen to group together in Right Ascension. If I have a large hole in the Right Ascension
sequence, I can pull a non-urgent object out of the second part of the list generated by the Near Earth
Asteroid Observation Planning Aid and add it to the plan. By the end of this process, I will have enough
targets to fill all the dark hours for that night.
Once the targets are selected, a VBA script creates an observing plan for input into DC-3 Dream’s ACP
Observatory Control Software. There are a few final tweaks made to the plan, including the stop time, so
the telescope does not keep imaging into daylight.
As I am getting near the end of this process, I roll the telescope out and bolt it onto the concrete driveway,
providing a good polar alignment. The telescope, a 12-inch LX-200 Classic, and observatory computer with
a PCI-card connected Apogee AP-7B CCD camera are powered up. This camera has 512 x 512 !!
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view of 13 minutes of arc. RoboFocus operates the focusing knob on
the back of the OTA, driven by FocusMax. MaxIm DL-CCD controls
the camera, and Software Bisque’s The Sky allows me to see where
the telescope is pointing.

The 12-inch LX-200 Classic with
Apogee AP-7b camera and
RoboFocus bolted down into its
observing position. An umbilical
runs back to the garage to allow
the telescope to be controlled by
the computer located there.

The observatory computer connects through wireless Ethernet to the
rest of my home network, and I control it through pcAnywhere. The
camera begins cooling-down while I upload the daily update of two
minor planet databases to the observatory computer (about 185
megabytes worth). I point the telescope at a bright star, and sync it to
the star’s position. Finally, I create a series of dark frames, one group
of nine for each different exposure time in the plan. Each group will be
median combined and the result used in the reduction process.

With everything ready, I start the plan running in ACP about 15 minutes
before evening nautical twilight ends. The telescope slews to the first
target, verifies its position, finds a star nearby and automatically focuses
the telescope. The telescope returns to the target and again verifies its
position. This takes about 15 minutes. If it is on target, the telescope
starts imaging the target, with exposure time controlled by the speed
of motion of the target. Faster moving targets require shorter exposures,
as short as a few seconds on a bright really fast moving object, but most of the time I use 50-second
exposures. If the subframe exposure time is too short, there will not be enough stars in the image to
determine the conversion factors (called plate constants) from the pixel position in the image to R.A. and
Declination in the sky. Exposures longer than 50 seconds have a higher tendency to result in elongated
stars. The number of repetitions is controlled by the faintness of the object.
After ACP finishes the first object, it moves to the next one in the plan and starts the process all over again.
If the object is faint and fast moving, ACP will move the telescope to follow it when it moves more than 3minutes of arc from the center of the field. This allows fainter objects that are moving fast to be observed
with a small telescope.
During the evening, I will download images from the observatory computer and process them. I monitor
the observatory computer to make sure that nothing unusual happens while I am still awake. Some problems
I have seen include trying to focus on double stars, never-ending slews, and not solving pointing images
correctly. All of these are rare, but they do happen. I go to bed at the normal time, leaving the telescope to
continue working for the rest of the night. If one of these problems strikes, I may end up with no images for
that target, or the plan may fail and the telescope will sit idle for the rest of the night.
The next morning, I download the remaining images and logs. If it is the weekend, I can immediately start
reducing the remaining objects. During the week, I will do the reductions in the evening after work. If I am
lucky and have another clear night, I will finish the reductions after I get the telescope working on the new
list of targets.
The reduction process is similar for each target. Since the objects I am working on are almost a million
times fainter than the faintest star you can see, I must “stack” a series of subframes to get sufficient exposure
to see the minor planet. Herbet Raab’s Astrometrica program will automatically dark subtract, flat field, and
!!
shift and stack the subframes with just information from the image and the name of the target. Since the!!
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exposure, the subframes are aligned and then
shifted as they are stacked to allow the image
of the minor planet to build up in one spot on
the final image while the stars form trails.
Once the stacking is done, I can blink the three
separate stacks of these subframes, and see
the minor planet move through the sky.

For each object, three
stacks are built, with each
subframe being shifted
slightly relative to the
previous one to keep the
image of the minor planet
(here 2008 CL72) in the
same place on the final
frame. This allows the
image of the minor planet
to build up in the final
image. Here the three
stacks have been combined
to show the motion of 2008
CL72 over a 24-minute
interval.

Astrometrica identifies the background stars
with the stars listed in a star catalog. I usually
use the UCAC-2, but sometimes use the less
accurate, but more star-dense USNO-B1.
Astrometrica uses the position of the star on
the plate and position in the catalog to
compute the translation matrix from the image
pixel position to the sky coordinates. I now
click on the minor planet in the image.
Astrometrica takes the minor planet’s image
and uses the brightness of the pixels in the image to fit a Gaussian point-spread function to the image. The
center of this mathematical model is the position of the target, allowing sub-pixel accuracy in the final
measurement. The calculated position is translated to RA and declination giving measurements to better
than half a second of arc. An approximate brightness measurement is also calculated, and this observation
is stored on my computer.
I then move the blink image forward one
stacked frame and repeat the process until
all the frames for that object are measured.
Sometimes the minor planet comes too close
to a star. When this happens, I can have
Astrometrica create a new set of stacked
images, minus the images where the minor
planet encountered the star. All the star trails
will now have a gap in them, and the trail for
the star that came near the minor planet will
have the image of the minor planet in the gap.
It can then be measured without the
brightness of the star skewing the measured
position.

2008 DG5 came too close
to a star during imaging.
Since the light from the star
would skew the position of
the minor planet toward the
star, the subframes where
the star was too close were
omitted from this stack,
leaving a gap in all the star
trails. The minor planet
can now be measured
without loss of positional
accuracy.

When I have completed measuring the night’s observations, I e-mail them to the Minor Planet Center, where
they are used to improve the orbit of the minor planets I observed that night. Finally, they publish the
observations for other astronomers in the Daily Orbit Update, issued by e-mail each night compiling the
day’s observations from all over the world.
I hope that I will never find a minor planet that will impact the Earth. Whether we would be able to stop
such an impact is uncertain, but the more advance notice we have of such an event, the more likely we can
prevent the impact. So I keep imaging the sky on almost every clear night, hoping that none of the NEOs I
measure will become the one that will change history.
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Outdoor Lighting Ordinances... Where Do We Stand?
By Steve Henderson
This time we’ll take a look at how Las Cruces,
nearby areas, and New Mexico are doing in
promoting good lighting. While I can’t cover
everything, I’ll hit a few key points.

Our first stop is right here in Las Cruces.
“Chapter 39 Outdoor Lighting” was adopted in
August of 2000. The purpose as described is to
regulate outdoor lighting fixtures; promote
efficiency; reduce lighting, which is detrimental
to the environment, or to the public use and
enjoyment of public and private property.

Here is a picture I took of LC from my patio in
Mesilla Hills. It shows how much light is going up
into the sky.

Hmm, let’s take a look. One of the provisions
of the ordinance was that adjustable lighting must be brought into compliance within 90 days from its
adoption. That was about 7 ½ years ago. As I’m sure you have all noticed, that provision wasn’t enforced.
Too late now, Elvis has left the building. A lot of lighting could have been (still can be) easily adjusted to
comply. Okay how about some good news. Most types of outdoor lighting fall under the scope of the
ordinance, which are mainly commercial. The majority of those new installations look good. We’re moving
in the right direction.
There are always compromises that have to be made when writing an ordinance. A couple of items that
bother me are the allowance of unshielded residential fixtures that have a single incandescent light having an
output of less than 100 watts (approx 1800 lumens). That’s a lot of light. This is a pretty typical exemption
in ordinances. The problem is there is no limit on how many of these “single incandescent lights” someone
can put up! Another is allowing signs to be illuminated from the bottom. In other words up light, shining
directly up into the sky. The provision that allows this is poorly worded, confusing, and unenforceable.
Probably the single most important item in the ordinance is the section that deals with grandfathering.
Existing non-conforming lighting in place before the adoption of the ordinance was allowed to continue to
operate. Now the best part, ALL existing lighting installations not exempted or excluded must be brought
into compliance within 10 years from the date of adoption. Very few ordinances have that provision. So in
August 2010 if the city strictly enforces this, the sky over and around Las Cruces will get darker! We can’t
just sit back and hope the city takes care of business. There are a few of us working to make sure the city
doesn’t let this date slip away as it did with the adjustable lighting provision. We also hope to revise and
strengthen the ordinance.
The town of Mesilla recently adopted an outdoor lighting ordinance. Much of the language is similar to Las
Cruces. The nice thing is they also have an expiration date on grandfathered lighting. Even though Mesilla
is a small town, it all adds up.
Our friends up in Alamogordo are doing their part to promote dark skies. It’s a simple and to the point
ordinance. They are restricting light going up into the sky by requiring shielding on most all lighting except
incandescent lamps of 150 watts or less. One provision that I haven’t seen before requires all light fixtures
on public or private property, no matter when they were installed to be turned off between 11pm and sunrise.
There are some exceptions. If the business is open after 11pm, security, roadway, and parking lot lighting
!!
are exempt. Also addressed is light trespass. They call it “residential spill-over” and I think it’s worth!!
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illuminates the user’s premises and does not spill over into neighboring residential areas so as to interfere
with the peaceful enjoyment of residential properties.” That one short section says so much. I’d like to see
something like this in the Las Cruces ordinance. They too exempted non-conforming lighting for a period
of time. “All non-conforming fixtures must be abandoned or replaced by fixtures conforming to this chapter
not later than July 1, 2005.” I haven’t been through Alamogordo at night to see if they are enforcing this, but
I hope so.
New Mexico has a statewide ordinance that covers any areas that aren’t covered by their own stronger
ordinance. The “Night Sky Protection Act” (NSPA) passed in April 1999. The stated purpose “is to regulate
outdoor night lighting to preserve and enhance the state’s dark sky while promoting safety, conserving
energy and preserving the environment for astronomy.” Sounds good huh? Let’s see. It has very minimal
requirements.... those compromises again. It requires that all outdoor lighting fixtures shall be shielded
except incandescent fixtures of 150 watts or less and other sources of 70 watts or less. Other sources would
include high pressure sodium and metal halide mostly found in commercial applications. Thankfully this
covers a majority of what is used commercially, as most are over 70 watts. Mercury vapor lights were
banned from being sold or installed after January 2000. Any non-conforming lighting in place before the
effective date of the NSPA is permanently exempted unless it becomes unrepairable or inoperable.
Replacement lighting is then required to comply. The problem with that is who would know if this was
done?
Even more of a problem is the apparent lack of enforcement by the state. I’ve been in contact with the New
Mexico Heritage Preservation Alliance who drafted and pushed the state to adopt the NSPA. In email
correspondence with the head of the dark sky section to find out how the state is doing in enforcing it, I was
pretty much given the brush off. I was able to track down who supposedly is responsible for enforcement.
It’s the Construction Industries Division (CID). I called them, listened to the menu options. No surprise
that there is no mention of the NSPA. I got through to a customer service person, who had no idea what I
wanted. She referred me to the Bureau Chief of Compliance. Now we’re getting somewhere, or so I
thought. I left a message asking for information about the NSPA. I never did receive a call back. At this
time I have to sadly conclude that the state doesn’t care about, or want anything to do with the NSPA. I
believe they adopted it under pressure from the Alliance thinking it would look good for them to be able to
say they care about the night sky as a natural resource, as long as they don’t really have to do anything about
it, which they’re not.
Keep an eye out on the club Yahoo group for updates on the Las Cruces ordinance, as we get closer to “the
date.” The response I’ve gotten back from some people within city government give me a positive feeling.
I think whether we are able to strengthen the ordinance or not, there is a good chance it will be enforced by
August 2010.

Dick Olson Remembered
Dear members, I must inform you of a significant loss our Society has
suffered. Saturday I found out that Dick Olson, also affectionately known
as Rocky, passed away at home recently. A former ASLC Director and
enthusiastic TSP veteran, Dick was a club mainstay for years after a long
prominent career in geology (thus the nickname). His dry wit and colorful
stories will be missed, as well as his dogged determination. Dick, we all
hope your view of the Jewel Box is now unsurpassed! Clear skies forever,
dear friend.... Nils Allen
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PhotoShop Toolbox: Selective Sharpening Using Layer Masks
By Bob Long
Frequently when imaging DSOs we are
faced with an image with a very high
dynamic range. Often it is a simple matter
to sharpen the brighter regions with a fairly
aggressive unsharp mask, a moderate
unsharp mask to the middle brightness, to
enhance detail, and a slight Gaussian blur to
the dim portions to hide the areas of low
SNR. Some of the methods to select these
regions include using the Lasso Tool from
the tools pallet to manually select the
portions you wish to adjust. Commonly the
Color Range option in the Select Menu is
also used. But what happens if you want to
sharpen the dust lanes in a spiral galaxy, or
Part of the Lagoon Nebula in hydrogen-alpha. The
enhance the fine filament structure of a bright
structure of the nebula can be sharpened to bring out detail
nebula? PhotoShop has a wonderful ability
without affecting other areas such as the stars and darker
called the Layer Mask that can be used in
areas of the image.
these situations. While there are many uses
for this option, this article will describe how
to choose just those portions of an image you want to sharpen. Once you see how to use the Layer Mask,
you will doubtless see many other places where it will be of use.
The first thing you need to do is process your image to give the best overall appearance you can. Do all of
your curves and levels adjustments, hue/saturation enhancements, basic sharpening and any other image
processing that you normally do.
Once you are satisfied with the image,
duplicate the layer using “Layer>Duplicate
Layer.” This will place an identical copy of
your image as a second layer on top of the
first. Select “Layers” from the Window
menu to see the layers. The default blending
method is “Normal.” This is what is needed
here, so if it is not, select it, as we want to
see the duplicate layer. Also make sure you
have selected the duplicate layer. You can
then
use
the
unsharp
mask
(“Filters>Sharpen>Unsharp Mask”) to over
sharpen the duplicate layer of the image.
Now when I say over sharpen, I mean that
you can sharpen the entire image to make
the portions of the image that you want to
sharpen look their best. This will often make

The same image with an overly aggressive Unsharp
Mask applied.
Continued on page 12
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The Astronomical Society
of Las Cruces (ASLC)

Minutes, February 2008 ASLC Meeting

is dedicated to expanding members and
public awareness and understanding of
the wonders of the universe. ASLC
holds frequent observing sessions and
star parties, and provides opportunities
to work on club and public educational
projects. Members receive The High
Desert Observer, our monthly
newsletter, membership in the
Astronomical League, including AL’s
quarterly A.L. Reflector. Club dues are
$35 per year. Those opting to receive
the ASLC newsletter electronically,
receive a $5 membership discount.
Send dues, payable to ASLC with an
application form or a note to: Treasurer
ASLC, PO Box 921, Las Cruces, NM
88004.

Call to Order: Nils Allen, President, Astronomical Society of Las Cruces
(ASLC), called the meeting to order at 7:35pm., February 22, 2008, Rm.
77, Dona Ana Community College.

ASLC members are entitled to a $10
discount on subscriptions to Sky and
Telescope magazine.

Committee Reports:

ASLC OFFICERS, 2008
Board@aslc-nm.org
President: Nils Allen
President@aslc-nm.org
Vice President: Jerry Garber
VP@aslc-nm.org
Treasurer: Janet Stevens
Treasurer@aslc-nm.org
Secretary: John McCullough
Secretary@aslc-nm.org
Immediate Past President:
Bert Stevens
PPresident@aslc-nm.org
Directors:
Wes Baker
Director1@aslc-nm.org
Kirby Benson
Director2@aslc-nm.org
Education Chairrman: Rich Richins
Education@aslc-nm.org
Newsletter Editor: George Hatfield
gmhlcnm@msn.com
Emeritus (life) Member: Walter Haas

President’s Comments: Nils repeated his goals for the Club this year,
stressing learning, sharing, and having fun. He gave a brief report on the
total lunar eclipse event at Veteran’s Park on February 20. He then
recognized several guests and new members present at this month’s
meeting.
Secretary’s Report: At the recommendation of the President, reading of
the minutes from the January meeting were dispensed with; there were
no objections. There was not an additional Secretary’s report.
Treasurer’s Report: The Treasurer was not available for this month’s
meeting and there was no treasurer’s report.

Observatory Committee: Rich Richins, Chairman, Observatory
Committee, reported that he had spoken with the Leasburg Dam State
Park (LDSP) park manager on February 19 and he had told Rich that the
Parks Department had responded to the Club’s observatory proposal.
Three (3) review letters had been received from other state agencies and
the tone was generally optimistic although there was some concern
expressed by the reviewers about the proposed observatory location and
the quality of the astronomical presentations to be provided by the Club.
There was the implication that a representative of the state would be
required to observe the presentation(s) and determine that the club
member(s) making the presentation was informed and knowledgeable
about his topic. Also, the reviewers indicated that the actual construction
work should be done by contractors as opposed to Club members (as
indicated in the proposal) because of liability issues. The park manager
reported that three (3) levels of professional support were typically
required: a general contractor, usually a state employee; an electrical
contractor, such as Club member Bernie Joplin; and a state licensed
structural engineer to certify the design. Rich has already contacted Dan
Lilly to possibly fill the role of structural engineer in return for
considerations from the Club. Dan estimates it may take one or two
months to prepare the formal package the state wants to see. Rich now
hopes for official ground breaking for the observatory to occur in the
April-May time frame.
Astronomy Day 2008: Wes Baker, Chairman, reported that planning
continues for this event on Saturday, May 10. Wes would like to keep
the Club’s activities for Astronomy Day relatively simple, stressing the
Club’s new observatory effort. He currently envisions a publicity !!

- 10 !“blitz” through as many outlets as possible, having “crews” of Club members with solar scopes in several
public venues during the day to encourage the public to attend the evening events, or at least visit the LDSP
site in the future. Wes needs posters, maps to LDSP, handouts, anything that would be a “hook” for the
evening event, such as a speaker at LDSP that Saturday night. He suggested that the Club might consider
doing regular solar observing, similar to the monthly MoonGazes, as a lead in to Astronomy Day 2008.
Ideas/input from the membership are welcome.
There were no additional standing committee reports.
Old Business:
1. Meade SolarMax telescope - see Treasurer’s Report above.
2. Club Membership Directory - no member objections to publishing personal contact information in a
member directory for members only have been received. Notice of plans for a directory were also published
in the February issue of the Club newsletter, High Desert Observer (HDO).
3. ASLC Asset Inventory - Jerry Gaber, vice-president is coordinating this effort. He did not have an update
on his progress.
There was no additional old business discussed.
New Business:
1. Club Logo/Insignia - Steve Henderson reported that he has received a number of suggestions for a Club
logo, some in color and others in black and white. He presented those he had received to the members
present via a digital display. All suggested designs will be posted and available via a link from the Club web
site and a vote will be held at the March monthly meeting. Additional discussion will be posted via the
aslc-nm.yahoo.group.
There was no additional new business for discussion.
Bob Long offered a motion to adjourn and Dave Dockery seconded. The business portion of the meeting
was adjourned at 8:00pm by acclamation of those present.
Announcements:
1. Messier Marathon - Steve Barkes announced the dates for the 2008 version of the Messier Marathon.
The primary date is March 8 with the cloud out/back-up date on April 5. The viewing site will be the Upham
DSO, maps on the web site.
2. Beginning Astronomy class - Rich Richins announced that the next class begins February 26 at the
Unitarian Universalist church. The current instructors, including Rich, would like to start bringing new/
additional instructors “on line.”
3. Star Parties - Chuck Sterling, Events Coordinator, reported on several school star parties held in February.
He also noted the dates for star parties already confirmed for March and April. March 5, Camino Real
Middle School; March 6, Central Elementary, they would also like a presentation to the 4th grade science
classes on the 3rd. Vince Dovydaitis and Bill Stein may support this. April 19, Chihuahua Desert Nature
Park. Although this is very close to full moon, this is the date requested by the park. A star party at Canutillo
!!
High School is also in the works. Jerry Gaber asked about a standard star party or school presentation.!!

- 11 !Rich stated that 4th grade bench marks are accessible through the web site.
4. Awards & Recognitions - Rich Richins was presented with the Take 5 award for his efforts in improving
and updating the Club web site. Bobby Franzoy, although not present, has been recognized by the community
of Hatch as being a “one-man astro show” (see the February HDO). Vince Dovydaitis suggested the Club
designate the 3 Best and 3 Worst Light Polluters in Las Cruces in connection with Astronomy Day.
There were no additional announcements made.
Observations: There were no observational reports offered.
Presentation: The speaker for the February meeting was Tom Krajci, an accomplished amateur scientist,
now living near Cloudcroft. He spoke on “New Advanced Telescope Designs for Amateurs - What’s New
in the Last Decade or So?” Tom overviewed this area that he has been participating in for several years you may have seen his name in many places on the Internet. Sub-topics included the general design process;
specific concepts and examples of scaling; new capabilities available to amateurs in the way of advanced
materials and custom electronics combined with portable computing power; new looks at old designs like
Dall-Krikham and hyperbolic primary Newtonians. Tom presented the “big picture” of the design process
in his presentation, and discussed some specific systems of audience members’ interest afterwards. This
presentation was recorded for playback via the Internet. It and other meeting presentations can be seen on
the web at http://www.aics-research.com/lectures/aslcnm/. The February 2008 monthly meeting concluded
at 9:03pm. Respectfully submitted by John McCullough, Secretary

Another Successful Star Party
By Chuck Sterling
We had a beautiful night for a star party at
Central Elementary. It was clear as a bell
and the seeing was very good, exceptionally
so for in town. The temperature got down
into the high thirties, but the wind was
practically dead calm. There were about a
half-dozen scopes and binoculars available
to view various objects, which included
Saturn (always a crowd pleaser), Mars, the
Pleiades (Subaru, Seven Sisters, M45), the
Great Orion Nebula (M42), Polaris, galaxy M81, and perhaps a few others. As you can see from the photo,
there were lines at nearly every station, and the general level of excitement was pretty high. Common
exclamations were, “WOW!”, and “Is that REAL?”. I think we were a hit!
I have to guess at how many people attended, but there probably were between one and two hundred,
including parents, aunts, uncles, and toddlers. Others may revise this estimate without hurting feelings.
Many thanks to Bernie Joplin, whose kids attend this school, for bringing up the idea of a star party to fourth
grade teacher David Uribe and getting the ball rolling. And to other teachers from Central Elementary,
without whom none of this would happen. And of course to all the astronomers that provide equipment,
time, and expertise, to make these events a success.
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PhotoShop Toolbox, continued from page 8
the rest of the image look grainy and far worse than before. Don’t worry about that. All we are interested
in at this point is getting the portions of the image that we wanted to sharpen looking their best; the rest of
the image will not be used.
Once the areas you are concerned about are to your liking, apply the Layer Mask. Making sure that the
duplicate image is selected, add the layer mask “Layer>Layer Mask>Hide All.” When you apply the layer
mask the over-sharpened duplicate layer is obscured by the mask. The layer is still there, but it is hidden

The duplicate layer with mask in place

The duplicate layer with selective sharpening applied (white areas on mask)

behind the mask. If you look at the layers window you will see a black rectangle beside the thumbnail image
of the duplicate layer. This is the mask that is hiding the over sharpened layer. Notice also that it is
highlighted with a white border. This tells you that the mask and not the layer is selected.
Now all we have to do is allow the portions
of the masked layer we want to be seen to
show through the mask. We do this by
“Painting” those portions white. Select the
Brush Tool from the Tools pallet, and make
sure that the foreground color is white.
Select a brush size appropriate for the size
of the areas you will be revealing. Try 5
pixels to start. Then simply paint on the
image where you want the sharpening to be
applied. As you do, the layer mask, which
is what you are actually painting on, will have
the black mask removed from these areas.
You will not see the white “Paint” on the
image, but you can see it on the layer mask
thumbnail.
What you will see on your image where you
paint, is the sharpened image of the duplicate
!!
layer showing through the mask. This!!

Image with sharpening applied to desired places. Use the
Opacity slider to adjust the impact of the sharpening as
needed.

-13 !allows you to apply to your image only the portions of the duplicate layer you desire. That is why it was
unimportant if the over-sharpened layer looked far less appealing than the original as a whole. Only the places
where the sharpening improves the image are allowed to show.
Since it is somewhat difficult to know for certain how much sharpening looks best until the two layers are
combined, I suggest you sharpen as much or perhaps more than you think is necessary. This is because, like all
layers, you can use the Opacity slider to vary how much the sharpened layer will show. Also you can use various
shades of gray rather than white on your brush tool to vary the amount of influence the sharpened layer will have
on “painted” the area of the final image.
Once you have applied all of the changes you want, just flatten the layers, “Layers>Flatten Image.”
Using this layer mask technique allows you to sharpen those areas in your image that were difficult or impossible
to select using other means. And, of course, while this article dealt with sharpening, the same technique can be
used for many other purposes (e.g., applying selective bluring).

As far as eye can see: Using double stars to gauge seeing
conditions
By Joseph Mancilla
Double stars have a very practical use for both the visual observer and astrophotographer. At low powers of 70x
and below the effects of bad seeing are not that noticeable, but at high powers they become very apparent.
Visually, the closest separation that the human eye can distinguish is about 4 arcminutes. Twice that, or 8
arcminutes is more practical and comfortable, but I find that 6 arcminutes will work well. Six arcminutes is equal
to about 1/53 of an inch viewed at 10 inches. Let’s take a double star with the separation of the pair being 2
arcseconds. Let’s use a magnification of 180x. Two arcseconds times 180x = 360 arcseconds; divided by 60
arcseconds = 6 arcminutes. We now have a 2 arcsecond separation appearing as a 6 arcminute image. By
observing the image of the two stars and the separation gap, you can make critical assessments about the seeing
conditions. If the seeing is shimmering and boiling, you will see it. If you are using a refractor and the sky is
calm, you will see the classic diffraction rings around the stars. If the two stars appear to be having a fistfight, the
seeing is pretty turbulent. Worse yet is what I call the “Amoeba effect.” That is when the two stars appear as one
blob that is struggling with itself and trying to split apart. They may momentarily split, but only to fly back
together as a quivering blob. If you are using a pair of stars with a 3 arcsecond separation, 120x will be required
to get the same 6' arcminute image. A 1.5 arcsecond pair will require 240x for the same 6 arcminute image. Keep
in mind the magnification used to examine the pair and the magnification that you intend to use when you are
actually observing or imaging. Also, if the pair of stars are of unequal magnitude ( a difference of 5 magnitudes
or greater ), you will need more power in order to split them. Here are a few sample stars: Zeta aquarii , Mag.
4.4 and 4.6, separation 1.6 arcseconds; Epsilon Lyrae ( double double ), Mag. 5.1 and 6.0, separation 2.8
arcseconds and Mag. 5.1 and 5.4, separation 2.2 arcseconds. There are many other stars that can be used as a
reference. One just has to spend a little time to find them. Happy Hunting!

April Issue of the HDO
Articles for the April issue should be sent to me by Saturday, April 12. Material should be sent as email
(GMHLCNM@msn.com) or as an attached Microsoft Word document. If you have any questions about
submitting something to the HDO, please don’t hesitate to contact me (532-5648 or via email). Thanks in
advance! George Hatfield, Editor, ASLC Newsletter.
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Reports from the Messier Marathon, First Try (March 8)
From Dave Dockery.... Joseph, Steve B, Nils, Bernie, and I participated last night. Unfortunately no one
took pictures. We were pretty sure going in that the weather was not going to support the full marathon so
Steve made the call that we’d try again on April 5. Several of us just ran the first part of the marathon (I did
the first 20) and then moved onto other observing lists. I think Nils and Bernie more or less stuck with it but
I left about 11:30pm and don’t know how far they got. It actually turned out to be a pretty nice night except
for some occasional patchy clouds and a breeze out of the west. It was certainly warmer than Friday night.
From Nils Allen.... The rest of us (Joseph, Bernie and I) didn’t stay too much longer, since the sky continued
to deteriorate with haze and some clouds after you left. First Joseph and then Bernie and I packed it in after
a lot of DSO observing.... think we got about 43 Messiers total and various other stuff. Kinda a crashcourse for Bernie on this stuff.
From Jerry Gaber... I planned on going out to Upham Saturday for the Messier Marathon but my Laptop
crashed Saturday afternoon and I didn’t get it back up till well after dark. It has all my charts and sky maps.
So needless to say I didn’t make it. Rather than feel sorry for myself I decided to once again run through the
list on Sunday night from my back yard observatory (The J&M Stargate Observatory) with my 10" LX200
GPS and yes using GoTo. I know it is almost like cheating, but I am not as familiar with the entire sky as
some of you. And I really wanted to check and recheck the accuracy of my GoTo. I got all the early ones
and made it through the Virgo Cluster by a little after 10:00pm. Then I slept till 4:00am and then finished all
but M30. So I got 109 of 110 and I must say I was very happy with the LX200 GPS GoTo. I think the new
Bucks Gears I installed made a big difference. Sorry I missed Upham but it was nice to get a few hours of
sleep in my own bed. I will try to make it to the April make up MM and do it again without GoTo (but with
digital setting circles).
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